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Upgrade to Amicus Attorney 2008 Small Firm Edition and SAVE 25%  

Amicus Attorney 2008 Small Firm Edition upgrades are on sale for the 
month of August. Amicus Attorney 2008 Small Firm Edition is the latest 
version... 
Read more  

Upgrade to Amicus Accounting 2008 and SAVE 25%  

Amicus Accounting 2008 upgrades are on sale for the month of August. 
Take your productivity to the next level with Amicus Accounting 2008 - our 
most robust... 
Read more  

  

 

There are no team members offices listed when I try to open another 
user's office? 

To open another team member's office that person must first grant you 
permission to do so by editing their office access settings. This is done from 
that user's office or by an Amicus Administrator... 
Read more  

  

 

 

Illinois State Bar Solo & Small Firm Conference 
Sept 4-5, 2008 
St. Charles, IL 

OECS Regional Law Fair 
Sept 12-13, 2008 
St. Lucia 

See Complete Event Listings 

 

 

Statutory Holiday Tracking 

Your administrator is responsible for maintaining 
statutory holiday listings in your Amicus 
Calendar. The program comes pre-configured 
with all key statutory holidays... 
Read more 

 

 

Statutory Holiday Tracking 

Your administrator is responsible for maintaining 
statutory holiday listings in your Amicus 
Calendar. The program comes pre-configured 
with all key statutory holidays... 
Read more 

 

 

Editing Unbilled Time 

To edit unbilled time transactions posted to client 
files you need to use the Edit Unbilled Function 
found in the Time module... 
Read more 
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Upgrade to Amicus Attorney 2008 Small Firm Edition and SAVE 25% during the month of August 

This is the upgrade Amicus Attorney IV, V, V+ and Small Firm users have been waiting for! Amicus Attorney 2008 Small Firm 
Edition is the latest version of the world's leading practice management software designed specifically for solo and small firms. 
With new features and functions, you will navigate more quickly, work more efficiently and manage your practice more easily 
than ever!  

New features of Amicus Attorney 2008 Small Firm Edition include: 

Improved Navigation and Workflow - quick and easy access to any Amicus module  
Redesigned Interface - it's now easier to move around within the product  
New Tasks Module - manage all of your To Do's in one place  
Explorer View on Documents - provides a new way to manage your documents  
Auto-Text - for quickly inserting frequently used words and phrases  
Email Signatures - automatically include an email signature in new emails  
Contact Merge - combine two contact records into one directly from the Contact Index  
Plus much more...  

Need more reasons to upgrade? See for yourself why there's never been a better time to 
upgrade your Amicus: 

Browse the Amicus Attorney 2008 Small Firm Edition Feature Tour  
Visit our Upgrade Portal and see what else is new in Amicus Attorney 2008 Small Firm Edition  

For more information:  

Contact your local Amicus Certified Consultant  
Contact your Regional Sales Manager at 800-472-2289 or via email at sales@amicusattorney.com  
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Upgrade to Amicus Accounting 2008 and SAVE 25% during the month of August  

Take your productivity to the next level with Amicus Accounting 2008 - our most robust product yet! With dozens of new 
functions and features, this is the upgrade you have been waiting for!  

New features of Amicus Accounting 2008 include: 

Redesigned Interface - new user-friendly interface enables you to navigate 
within the product with ease  
Change Client Matter ID - easily change the client on an existing Matter  
Optional Payroll Integration - for all your payroll needs  
One Step Trust to AR Entry - transfer trust to AR in one step  
Plus much more...  

Need more reasons to upgrade? See for yourself why there's never been a better 
time to upgrade your Amicus: 

Browse the Amicus Accounting 2008 Feature Tour 
Visit our Upgrade Portal and see what's new in Amicus Accounting 2008  

For more information:  

Contact your local Amicus Certified Consultant  
Contact your Regional Sales Manager at 800-472-2289 or via email at sales@amicusattorney.com  
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"There are no team member offices listed when I try to open another user's office?" 

To open another team member's office that person must first 
grant you permission to do so by editing their office access 
settings. This is done from that user's office or by an Amicus 
Administrator.  

Granting access to your office 

To grant firm members access to your office: 

1. Select My Profile from Office Preferences  
2. Click Edit to display the Person Edit dialog  
3. Select Office Access at the bottom right of the window that 

appears  
4. In the Guest section of the window, click the (Select 

People) buttons to add or remove Guest Assistants and/or 
Guest Colleagues  

5. When you are finished, click OK  
6. Click OK in the Office Access dialog.  

Opening another firm member's office 

When you want to see or change information in another firm 
member's office: 

1. Close all dialogs to make sure that your information is 
saved  

2. Choose Open Another Office in the navigation list of your 
Office window  

3. The Select Office dialog appears listing the firm members 
who have granted you access to their office  

4. Select a firm member and click OK  
5. This opens the other firm members office so you can look 

up information and perform tasks, as determined by your 
usual security permissions and further limited by your 
current status as Guest Assistant or Guest Colleague 
(determined by the Office Owner)  

Note: There are 2 different types of access to grant, each 
offering a different level of permissions when in another person's 
office, Guest Assistant and Guest Colleague.  
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Preferences > My Profile > Edit > Office Access > Select People

Open Another Office 

  

You have received this eNewsletter as you are a current Amicus Attorney customer or have previously requested information or this newsletter from our company.

Amicus and Amicus Attorney are registered trademarks and Amicus Accounting and Amicus Mobile are trademarks of Gavel & Gown Software Inc. © 2008.  
www.amicusattorney.com  



August 2008 -- Volume 6, Issue 5

    

 

  

Statutory Holiday Tracking 

Your administrator is responsible for maintaining statutory holiday listings in your Amicus 
Calendar. The program comes pre-configured with all key statutory holidays depending on the 
country selected upon installation (US, UK or Canada). All other jurisdictions can configure their 
own holidays within the program depending on their needs. 

Holidays in Premium Edition can be specified as statutory, observed, both, or neither. This 
means that a holiday can be listed in Amicus Attorney as observed, while not being statutory. 
Or a holiday may be a national statutory holiday, but not observed in your jurisdiction. You may 
also choose to include holidays that are neither observed nor statutory. St. Patrick's Day for 
instance may be marked as not observed in that you may wish to have it appear in the Amicus 
Calendar, but you don't close the office to celebrate it. 

All Holidays are reflected in each Firm Member's Calendar views. 
Observed Statutory Holidays are not considered business days 
for purposes of scheduling Repeating Events and Dependent 
Linked Events, and optionally, for scheduling the Deadlines of To 
Do's. Similarly, Observed Holidays are not considered business 
days when calculating the average billable hours in Time Entry 
statistics.  

NOTE: Holiday changes do not take effect immediately- Calendar 
views, Events, and statistics will be automatically adjusted 
overnight by the Daily Checks process. 

Should you wish to add new State or Provincial holidays to the 
list of national holidays, Amicus Attorney makes it easy to make 
the necessary changes. 

  

Configuring 
Holidays 

Firm-
wide 
configuration 
changes 
can 
only 
be 
made 
by a 
user 
with 
administrator 
rights. 

To 
customize 
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Calendar > List View > Holidays 

Administrator: Firm Settings > Holidays > Edit



holidays, go to the Firm Settings view and click Calendar - Holidays. The Holidays view appears. 

Adding / Editing Holidays: 
If you click New (or select an item and click Edit), the Holiday dialog appears.  

Enter the title. Enter a date in the Effective Date box. Select the Statutory and/or Observed checkboxes as appropriate.  

Select the repeat frequency in the list box, and then fill in the appropriate details that appear for the frequency selected.  

Removing Holidays: 
To delete a Holiday, select it in the list, click Edit, and then click Delete in the Holiday dialog that appears.  

When complete, click OK to accept changes. 

Firm Member Preferences 

As stated above, Amicus Attorney helps with scheduling so that 
events aren't inadvertently entered into the calendar over a 
holiday. Preferences can be set for individual Firm Members for 
weekend and holiday scheduling. Separate preferences can be 
set for repeating events, linked events, and deadlines (Move to 
the next business day | Move to the previous business day | 
Schedule it anyway | Cancel that occurrence).  

Generally, in order to avoid missing an important date you would 
probably want Amicus to move the date ahead, but you can 
choose to configure the program as you see fit. 

 
 
 
Date 
Calculator 

The 
Date 
Calculator 
in 
Amicus 
Attorney 
(Tools 
> 
Date 
Calculator) 
can 
also 
take 
into account weekends and holidays when setting dates. You have the option to choose how to proceed if the calculated day 
falls on a weekend or holiday (Show it anyway | Show the previous business day | Show the next business day). In the actual 
calculation you can also choose to specify business or calendar days (in addition to weeks, months and years). 

Therefore your ability to record statutory holidays goes well beyond just displaying the dates in the Amicus Calendar, they can 
be taken into account when scheduling events. 

  

For more information on Amicus Attorney 2008 Premium Edition visit www.amicusattorney.com. 

Preferences > Calendar > New Entries

Tools > Date Calculator
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Statutory Holiday Tracking 

Your administrator is responsible for maintaining statutory holiday listings in your Amicus 
Calendar. The program comes pre-configured with all key statutory holidays depending on the 
country selected upon installation (US, UK or Canada). All other jurisdictions can configure their 
own holidays within the program depending on their needs. 

Amicus Attorney allows you to distinguish between observed and non-observed holidays. For 
instance St. Patrick's Day may be marked as a non-observed holiday in that you may wish to 
have it appear in the Amicus Calendar, but you don't close the office to celebrate it. New Year's 
Day would be considered a Statutory Holiday in that it will appear in the Amicus Calendar and it 
would not be considered a normal business day for the purposes of scheduling events. This 
distinction is important because you can set preferences in Amicus Attorney to move dates and deadlines so that they do not 
fall on observed holidays (or weekends). Observed holidays would therefore be taken into account when scheduling events, 
while non-observed holidays would be treated as regular business days.  

Should you wish to add new State or Provincial holidays to the list of national holidays, Amicus Attorney makes it easy to make 
the necessary changes. 

Configuring Holidays 

Firm-wide configuration changes are made within the Amicus 
Administrator. In order to customize the Statutory Holidays list, 
choose Calendar from the Configure Menu, then click the 
Statutory Holidays tab.  

Change the details of a holiday 
Double-click the holiday to see its Event Details. Make the 
desired changes, then click OK.  

Add a holiday 
Click New. Fill in the details in the Event Details window, then 
click OK.  

Remove a holiday 
Double-click the holiday. In the Event Details window, click 
Delete.  

When you are finished customizing the holiday list, click OK at 
the bottom of the window.  

  

 
Team Member Preferences 

Each individual team member can set their own preferences for 
weekend and holiday event rescheduling. Separate preferences 
can be set for recurring events, deadlines, and linked events 
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(schedule the event anyway | move to the previous business day 
| move to the next business day | cancel the occurrence). 

By default the preference is set such that deadlines will be moved 
up to the previous business day so that they will not be missed, 
while recurring and linked events will be moved to the following 
business day. 

Date Calculator 

The Date Calculator in Amicus Attorney (Amicus > Date 
Calculator) can also take into account weekends and holidays 
when setting dates. You have the option to choose how to 
proceed if the calculated day falls on a weekend or holiday (Show 
it anyway | Show the previous business day | Show the next 
business day). In the actual calculation you can also choose to 
specify business or calendar days (in addition to weeks, months 
and years). 

Therefore, your ability to record statutory holidays goes well 
beyond just displaying the dates in the Amicus Calendar, they 
can be taken into account when scheduling events. 

For more information on Amicus Attorney 2008 Small Firm Edition visit www.amicusattorney.com. 

File > Preferences > Calendar 
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Editing Unbilled Time 

To edit unbilled time transactions posted to client files you need to use the Edit Unbilled 
Function found in the Time module. If a transaction has been billed and you still want to edit 
it, you must reverse the bill first. 

1. Go to Time > Edit Unbilled  
2. Select the Client Matter ID  
3. Click on the transaction and click Edit  
4. Make your changes and click Save  
5. To see the transactions you have modified, click the Edited Entries tab.  
6. If you decide not to save the changes to a transaction, highlight the entry and click 

Delete.  
7. Continue editing 

transactions or click 
Post  

Tips for editing unbilled 
time 

To automatically insert 
frequently used text in 
the description field, 
type the Auto-Text 
code in the field and 
press the space bar.  
Billed transactions 
cannot be edited. If a 
transaction has been 
billed and you still want 
to edit it, you must 
reverse the bill first.  
To print unprinted Edit 
Unbilled audits, go to 
General Ledger > 
Unprinted Audit Reports and select Time Entry or Edit Unbilled audits. New Time Entry audits and Edit Unbilled audits 
print together.  

Amicus Accounting 2008 Overview 
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ACCOUNTING FREE TRIAL 
click here 

Time > Edit Unbilled
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